
CCD Imaging with the Philip Wetton 

Telescope 

 

Fraser Clarke (fraser.clarke@physics.ox.ac.uk) 

Version 0.5 

 

 

 

 

 

 

 

 

 

 

 

Revision History 

Version Date Author Changes 

0.5 2012/02/03 FCl Added teamviewer info. Updated settings file 

location. Added summary section. Added more 

information on setup. Created new settings file. 

0.4 2012/01/20 FCl Corrected some bits. 

0.3 2012/01/03 FCl Revised structure and updated information for 

2012 MPhys projects 

0.2 2011/11/18 FCl Added more information on operations from GJW 

documents 

0.1 2010/12/12 FCl First release 

  



CCD Imaging with the PWT  v0.5 

Fraser Clarke Page 2 of 34  07/02/2012 

1 SUMMARY ................................................................................................................................................... 4 

2 OVERVIEW & GETTING STARTED ...................................................................................................... 4 

2.1 SYSTEM DESCRIPTION ........................................................................................................................................... 4 

2.2 COMPUTING ............................................................................................................................................................ 4 

2.2.1 Data location ................................................................................................................................................. 4 

2.2.2 First log in ....................................................................................................................................................... 5 

2.3 WIKI ........................................................................................................................................................................ 7 

3 SAFETY ......................................................................................................................................................... 8 

3.1 PERSONNEL SAFETY .............................................................................................................................................. 8 

3.1.1 Ladders ............................................................................................................................................................ 8 

3.1.2 Lone working................................................................................................................................................. 8 

3.1.3 High voltage ................................................................................................................................................... 8 

3.1.4 Cables ............................................................................................................................................................... 8 

3.2 EQUIPMENT SAFETY .............................................................................................................................................. 8 

3.2.1 Telescope ......................................................................................................................................................... 8 

3.2.2 Dome park position ..................................................................................................................................... 8 

4 INSTALLATION AND SET-UP .............................................................................................................. 10 

4.1 EYEPIECE TO CCD ...............................................................................................................................................10 

4.2 CCD TO EYEPIECE ...............................................................................................................................................11 

5 OPERATIONS ............................................................................................................................................ 12 

5.1 START-UP..............................................................................................................................................................12 

5.1.1 Telescope ....................................................................................................................................................... 12 

5.1.2 CCD .................................................................................................................................................................. 13 

5.1.3 Focuser ........................................................................................................................................................... 13 

5.1.4 Dome ............................................................................................................................................................... 13 

5.1.5 Software ........................................................................................................................................................ 13 

5.2 OBSERVING ...........................................................................................................................................................21 

5.2.1 Pointing the telescope .............................................................................................................................. 21 

5.2.2 Centering targets ....................................................................................................................................... 21 

5.2.3 Guiding ........................................................................................................................................................... 21 

5.2.4 Observing sequences ................................................................................................................................. 21 

5.2.5 Focusing ........................................................................................................................................................ 24 

5.2.6 Calibration ................................................................................................................................................... 26 

5.3 SHUT-DOWN .........................................................................................................................................................28 

5.3.1 Telescope ....................................................................................................................................................... 28 

5.3.2 CCD .................................................................................................................................................................. 29 

5.3.3 Dome ............................................................................................................................................................... 29 

6 WEATHER ................................................................................................................................................. 31 

6.1 WEATHER LIMITS ................................................................................................................................................31 

6.1.1 Rain ................................................................................................................................................................. 31 



CCD Imaging with the PWT  v0.5 

Fraser Clarke Page 3 of 34  07/02/2012 

6.1.2 Wind ................................................................................................................................................................ 31 

6.1.3 Humidity........................................................................................................................................................ 31 

6.1.4 Temperature ................................................................................................................................................ 31 

6.1.5 Snow/Ice ....................................................................................................................................................... 31 

6.2 CONDITIONS .........................................................................................................................................................31 

6.2.1 All Sky Camera ............................................................................................................................................ 31 

6.2.2 Cloud/rain monitor .................................................................................................................................. 32 

6.2.3 Satellite images .......................................................................................................................................... 32 

6.2.4 Radar images .............................................................................................................................................. 32 

6.2.5 Local conditions ......................................................................................................................................... 32 

7 TROUBLE-SHOOTING ............................................................................................................................ 33 

7.1 COMMON PROBLEMS ...........................................................................................................................................33 

7.1.1 “Home search failed” ................................................................................................................................ 33 

7.1.2 MaxImDL keeps trying to run its installer ....................................................................................... 33 

7.1.3 MaximDL won’t connect to the telescope ......................................................................................... 33 

7.1.4 POTH crashes and refuses to restart .................................................................................................. 33 

7.1.5 How do I start “TaskManager” over a remote desktop? ............................................................ 33 

7.2 REMOTE SUPPORT ...............................................................................................................................................33 

7.2.1 Downloading teamviewer ...................................................................................................................... 34 

7.3 CONTACT INFORMATION ....................................................................................................................................34 

 



CCD Imaging with the PWT  v0.5 

Fraser Clarke Page 4 of 34  07/02/2012 

1 Summary 
This document is a guide to CCD Imaging with the Philip Wetton telescope at the 

University of Oxford. It is intended as a guide and reminder for user who’ve already had 

some training on the system. Section 2 gives and overview of the system and describes 

the initial set-up required to use it. Section 3 highlights some of the health and safety 

issues specific to the telescope and dome. Section 4 describes how to change the 

telescope to CCD from eyepiece, and vice-versa. Section 5 outlines how normal 

operations work, and section 0 gives information on how to judge the observing 

conditions and weather. Finally section 7 lists common problems and how to fix them. 

2 Overview & Getting Started 

2.1 System description 
Overview of the system 

System diagram 

A windows machine called “wettonpc1.physics.ox.ac.uk”, located in the dome, runs the 

main control programmes and communicates with the hardware. This machine 

communicates with the hardware via RS232 and USB cables to a USB hub located under 

the telescope. The connection to the dome is via a USB connection to a wireless control 

pad. This communicates with the controller boxes mounted on the dome. 

The main programme is called “MaximDL”. This controls the telescope and the dome via 

a server programme called “POTH”. POTH also takes care of sychronising the dome 

position with the telescope. MaximDL communicates directly with the CCD camera, 

guide camera and the focuser. MaximDL and POTH run on wettonpc1. When images are 

saved from MaximDL, they are written to a directory on the astrophysics AstroDAQ 

shared disc. They are then visible from any machine in astrophysics accessing this share. 

A new directory is created for each day, at midday.  

A secondary machine called “wettonpc2.physics.ox.ac.uk”, also located in the dome, 

controls the all sky camera, temperature monitoring, and cloud/rain sensor. You should 

not have to log in to this machine. 

2.2 Computing 
The telescope is now controlled from a Windows machine called “WettonPC1”. Anyone 

with a PHYSICS account can log into this machine locally and control the telescope. 

However, to log in remotely, and write data to the shared disc, you must be added as a 

member of the “Wetton Users Group” by central physics IT 

(ITsupport@physics.ox.ac.uk).  

2.2.1 Data location 
The default storage location for Wetton data is; 

afp://asfs02.phsycis.ox.ac.uk/AstroDAQ/Wetton/ 
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This location can be mounted as a share from your department Mac, so it is easy to copy 

data off for analysis. All members of the department should have read access to these 

directories. Only members of the “Wetton Users Group” have write access to these 

directories. No data should ever be deleted/modified in these directories. When you are 

reducing data, please make a separate copy in another location before starting. 

This share is also available from the wettonpc1 desktop via the “Wetton Data” directory 

icon. 

2.2.2 First log in 
Some software set-up needs to be run the first time you use the CCD with MaxImDL. 

Follow the steps below. 

1. Start-up MaxImDL by clicking on the Desktop icon. This will create the default 

start-up/settings directories. These should be in “My Documents\MaxIm DL 5\”. 

Close MaxImDL down. 

2. Copy the file Settings_PWT_20120203.zip from; 

Desktop\Wetton Data\Settings\ 

 to  

My Documents\MaxIm DL 5\ 

 and unzip the file in this directory. This will create a set of files called 

“XXX,Wetton Imaging.txt” in the Settings directory. 

3. Now restart MaxImDL and go to “File->Configurations...” to open up the config 

window.  

4. Select & load "Wetton Imaging" (or other appropriate configuration). This will 

restart MaxIm, and load the default configurations for the CCD. 

5. To put your own name into the FITS header, go to "File->Settings..." and then 

select the "FITS header" tab from the window (Figure 1). Click on "OBSERVER" 

and enter your own name in the “Value” field. Click “Set” to enter the data, and 

Apply & OK to finalise. 

6. To fix an apparent bug in POTH initialisation… Connect to the telescope to start 

POTH (look at the windows task bar). Open up POTH and click on “Setup” 

(Figure 2) and then “Setup” on Dome Connection panel (Figure 3). This brings up 

another window. Check that Set Park Position is at 230 degrees, and COM Port 

Number is COM7. Click OK (on both windows).  
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Figure 1: Changing the default OBSERVER name in MaxImDL via the File->Settings window. 

 

Figure 2: POTH window showing telescope connected and dome not connected. Click on 

"setup" to bring up telescope/dome setup window. 
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Figure 3: POTH telescope/dome control setup. Click “Setup” on Dome Connection area to 

bring up dome setup window. This needs to be run once before POTH will connect to the 

dome (even if you don't change anything!) 

MaxIm should now be set-up for CCD imaging by default. Any parameters you change 

whilst you are using MaxIm should be automatically stored in the configuration files and 

be available at set-up next time. 

2.3 Wiki 
The PWT has a wiki-site, which contains more information on the telescope/reference 

data/schedules etc. It is available at; 

http://astrowiki.physics.ox.ac.uk/PWT/ 

Please make use of the Wiki to store information on your project, etc. This helps other 

people to make observations for you if you need. 
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3 Safety 

3.1 Personnel safety 
Please take normal health and safety into account when working in the dome. Below are 

a few points in particular which are specific to the telescope dome. 

3.1.1 Ladders 
The dome contains a short library type stepladder to help you reach the top of the 

telescope (i.e. to remove the lens caps). The ladder is rather wobbly and does not have a 

full hand rail. Please take extra care when using this. 

3.1.2 Lone working 
The department’s health and safety guidelines permit lone working at night for ‘general 

office duties’1, which covers normal observing from your office/lab. If you need to 

physically go up to the dome during the night, you should consider this an increased risk 

and take appropriate action – specifically; what will happen if you trip/fall on the stairs? 

An appropriate risk reduction strategy may be to let someone know that you are going 

up to the dome, and when you return to your office/lab. If you are overdue, they would 

know to come and look for you. 

3.1.3 High voltage 
The dome track contains an exposed 240V track. The power to this MUST be turned off 

whenever the dome track is open. If the cover of the dome track is taken off for any 

length of time, the power switch must be locked off with a padlock. 

3.1.4 Cables 
Take care to avoid the cables running between the telescope and the computer. 

3.2 Equipment safety 
If in doubt, close the dome. 

3.2.1 Telescope 
The telescope is relatively robust. Take care however when removing/replacing the 

telescope covers. Take care with the cables to/from the telescope and the handset 

controller. 

3.2.2 Dome park position 
The dome should be parked at end of each observing session. This places the dome slit 

at 230 degrees (i.e south-west) and means the drips from the back of the dome fall 

                                                             

1 https://www-cmphys.physics.ox.ac.uk/Healthsafety/2007/13.1-

%2013.2%20Risk%20Assessments.pdf  
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harmlessly onto the floor. Other park positions could allow the dome to drip onto the 

computers.  
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4 Installation and set-up 
The telescope set-up should only be changed by an experienced operator. 

4.1 Eyepiece to CCD 
*** To add pictures *** 

1. Put the telescope to the park position and turn off the power 

2. Unscrew the 4-inch thread adaptor from the back of the telescope, including the 

45-degree fold & eyepiece.  

3. Store all parts in the cupboard (right hand side) 

4. Screw the moonlite focuser onto the 4-inch thread. The focuser should be 

snugged up in the thread only, with the motor axis roughly horizontal 

5. Feed the CCD power cable and two USB cables through the fork, so that the 

cables run smoothly out to the South. 

6. Carefully place the CCD nosepiece into the focuser, and insert it up fully up to the 

lip. The SX guider should be approximately vertical above the main CCD. Tighten 

in turn the three silver thumbscrews to secure the camera to the focuser. Make 

sure the camera is well held and stable in the focuser. Note, this step can be quite 

fiddly – the camera should feel very solid when properly mounted. 

7. Cable up the instruments 

a. Plug in the camera USB cable to the SBIG camera (black USB cable) 

b. Plug in the camera power cable to the SBIG camera 

c. Plug in the guider USB cable (care! Fragile connector!) 

d. Plug in the white RJ45 guide cable to the telescope (“CCD Guider” port) 

e. Plug in (and screw in strain reliefs) the grey DB9 serial cable to the 

focuser (this cable is fixed to the focuser control box, and coiled under 

the telescope) 

8. Move the counterweight from the ‘eyepiece’ position to the ‘ST8’ position. Take 

care when loosening the mounting screw and be sure to hold the counterweight.  

9. Carefully screw the mirror tension spring into the back of the mirror. Be very 

careful to make sure the screw seats properly into the nut – it takes a little bit of 

feel to judge this. Do not tighten the screw down yet. 

• The final sections can only be done at night 

10. Start-up and home the telescope as normal 

11. Slew to a bright star, about 2—3 magnitude. 

12. Take a short (1s) exposure on the CCD, you should see an out-of-focus 

“doughnut” on the image. If you do not see the star, the pointing is probably off. 

Check with the finder scope (see below) and fix the pointing before going any 

further. 

13. Set the moonlite focuser to the middle of its range (see §5.1.5.1.2.1) 

14. Set MaxImDL to take continuous short exposures (0.1s or so, such that you can 

see the star). 

15. Focus the telescope using the mirror focus screw until you get the star roughly in 

focus. Be sure that the mirror lock screw is not tightened when you are doing 

this. You may need to adjust the telescope pointing to keep the star in the field of 

view. 
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16. Once the star is in focus (get it as close as you can), tighten down the mirror lock 

screw completely. 

17. Stop the continuous images and do a focus run with MaximDL (§5.2.5) 

4.2 CCD to Eyepiece 
TBC 
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5 Operations 
This section gives an overview of how to start-up, observe with and shut-down the 

system. It is split into 3 main sections; 

• Start-up 

• Observing 

• Shut-down 

5.1 Start-up 
A quick reminder of the system start-up; 

• Check the telescope, CCD and focuser are powered on 

• Uncover the telescope and home it 

• Make sure dome controllers are in “remote” 

• Decide which part of the dome is open (upper or lower) and open the dome 

• Log in to wettonpc1 computer 

• Start-up MaximDL 

• Connect to Telescope (starts up POTH) 

• Connect to Dome 

• Connect to Focuser 

• Connect to CCD and turn on coolers 

The sections below provide more details on each of these steps. 

5.1.1 Telescope 
Carefully remove and store the plastic sheet covering the telescope. Be careful the sheet 

doesn’t get caught on the guider telescope and rip. 

Leave the mirror caps on for just now. Once the dome is opened, remove the mirror caps 

(main telescope is a pull-off cap, the guider telescope is a screw-off cap) and store on the 

desk. 

Switch on the telescope plug at the back of the pier (South side), and then power on the 

telescope with slide switch on the main panel (***photo***). The system takes about 15 

seconds to start-up. When it is ready, the hand controller shows **** (photo?). 

5.1.1.1 Homing the telescope 

The telescope must be “homed” after it is turned on, or it will not point accurately. To do 

this via the handset controller, go to “TELESCOPE”->”HOME”->”FIND”. The telescope 

will then move in both axes for ~60 seconds to find it’s reference position. When 

finished, the handset should say “Home search complete”. If the home search fails, make 

sure the telescope is near it’s default location (23 hours HA and 0 degrees declination) 

and try again. 
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5.1.2 CCD 
The CCD is usually left on to keep the cooling stable. If not, switch on the ST8 plug at the 

back of the pier (South side), and then turn on power supply brick mounted on the 

South of the telescope mount (note, this is usually just left on). If the CCD is connected to 

the USB port of the computer, the fan should start to spin. 

Note that when the CCD cooling is turned on, ice may form on the detector. This usually 

clears after several hours, so it is worth turning the CCD cooling on early in the day. 

5.1.3 Focuser 
The focuser is usually left switched on. If not on, switch on the focuser plug at the back 

of the pier (South side). Check the red light is illuminated on the small focuser controller 

box under the telescope. 

5.1.4 Dome 
Turn on the key power to both the dome controller boxes, and set them both to 

“Remote”. (***photo ***) 

5.1.5 Software 
Log into the telescope control computer at wettonpc1.physics.ox.ac.uk with your 

PHYSICS username and password. If you are in the Wetton Users Group, you can log in 

remotely via RemoteDesktop (available from SelfService on the dept macs). There are 

several telescope specific programmes (MaxImDL, POTH and DS9), which should be 

available on the Desktop, and in the “Wetton Telescope” folder at the top of the All 

Programs list. See Figure 4 below. 
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Figure 4: Screen grab of the Wetton icons and folder on wettonpc1. Of interest are MaxIm 

DL 5, POTH, DS9 and the ‘Wetton Data’ directory. 
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5.1.5.1 MaxImDL 

MaxImDL is an extensive package with many features. We recommend you use the in-

built help files (Figure 5) both for problem solving, and to learn the capabilities of 

features. In this section we provide details on the features most commonly used in 

standard PWT observing. 

 

Figure 5: Accessing the MaxImDL help package 

Start-up MaxImDL by double clicking the desktop icon, or from the Wetton Telescope 

folder on the start menu. MaxImDL should start-up with the main windows open, but if 

it doesn’t you can open them easily. There are four main windows to control MaxImDL; 

1. Screen Stretch 

2. Information 

3. Camera Control 

4. Observatory Control 

They are opened by clicking the four buttons on the “Standard” toolbar (if this is not 

visible: View->Toolbars->Standard). This will bring up four new windows, which you 

need to distribute prettily around the screen (this is very annoying and the windows 

keep getting in each other’s way, sorry!). 

 

Figure 6: Buttons to open the four main windows of MaxImDL. 
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Figure 7: Four main MaxImDL windows open 

 

With the windows open, we need to connect the software to the devices (camera and 

telescope). In the Observatory and Camera Control, choose the “Setup” tab. Click on 

“Connect”/”Connect All”. If you haven’t started it already, this will start POTH.  

5.1.5.1.1 Connecting the Telescope 

From the Observatory window, go to the Setup tab and click “Connect” on the telescope 

subsection (Figure 8). This will open up the POTH programme in the background, and 

should connect to the telescope (see §7.1.3 for a relatively common connection problem 

at this point). Check in the “Telescope” tab to see if the information from the telescope is 

now available (Alt/Az etc). 
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Figure 8: Telescope/Dome/Focuser connection subsection of the observatory window. 

Click "connect" to connect to the telescope etc. 

You can also click “Connect” on Dome and Focuser at the same time. 
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Figure 9: Telescope subsection in Observatory window. When connected, information is 

displayed in the upper box. The telescope here is current not tracking. Check the "sidereal 

tracking" box to turn on tracking. 

5.1.5.1.2 Connecting the Focuser 

Click “connect” on the Focuser 1 subsection of the Observatory Setup tab (see above). 

The moonlight focuser should now be connected and report its position in the “Focuser” 

tab. 

5.1.5.1.2.1 Zeroing the focuser 

This step only needs to be done occasionally. 

The moonlight focuser is an absolute focuser, and will keep its position after a power-

off. However, it is possible for the focuser tube to slip in the motor, and therefore lose its 

position. If this happens, re-zero the focuser with the following steps (it’s worth doing 

this each time the telescope set-up is changed, before you focus the telescope at night); 

1. Disconnect the focuser and click on the “setup” option (right arrow above 

“disconnect”; Figure 10) 

2. Type in the current position as 5000 counts, and click “set” (Figure 11) 

3. Reconnect the focuser, and via the focuser tab, move the focus to 0 counts with 

the “absolute” position setting (Figure 12). This will run the focuser into its 

lower limit. Check visually that the motor keeps running once the tube stops 

moving – you should hear the motor noise change. 
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4. Now back the focuser out to 2500 counts to put it in the middle of its range. 

 

Figure 10 : Focuser setup option 

 

Figure 11: Setting the focuser position to 5000 to enable the focuser to zeroed at the 

hardware limit. Tick the “set” box highlighted, then OK. 
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Figure 12: Focuser control subsection in the observatory window. The "absolute" feature 

highlighted allows you to move the focuser between 0 and 5000. 

5.1.5.1.3 Connecting the Dome  

Click “Connect” on the Dome subsection of the Observatory Setup tab (see above). If 

POTH is not already open, it should now open. The dome may move slightly as it looks 

for its reference. 

In POTH, once the dome and telescope are connected, tick the “Slave to scope” button. 

The dome will now track the telescope. (Figure 13) 

Note - POTH will be unresponsive whilst the dome is moving. 
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Figure 13: POTH window showing connection to telescope and dome. Dome is currently 

not slaved to the telescope, and the telescope isn't tracking ("Track" and "Slave Dome" 

boxes are unchecked) 

5.1.5.1.4 Connecting the CCD 

The CCD is started-up from the “Camera Control” window. In the Set-up tab, click 

“connect”. The cameras should be set as ST8 (Camera 1) and SX (Camera 2).  

5.1.5.1.4.1 Cooling temperature 

Click on “cooler” and set the cooling temperature to –20C. Turn the coolers on.  

5.2 Observing 

5.2.1 Pointing the telescope 
TBC 

5.2.2 Centering targets 
TBC 

5.2.3 Guiding 
TBC 

5.2.4 Observing sequences 
MaxImDL allows you to build sequences of observations (i.e. 10 exposures of the same 

object), which it will then carry out automatically without intervention. This is a great 

help and avoids you having the click on the computer every 2 minutes! 

To access the autosave menu, click the small “AutoSave” at the right hand side of the 

Expose tab in the Camera Control window (see Figure 14).  
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Figure 14: Location of the autosave button. 

This will open a new window which holds the AutoSave configuration information. 

Figure 15 shows the AutoSave window set up to take a sequence of 10 bias frames.  

 

Figure 15: AutoSave configuration window set-up to take a sequence of 10 bias frames. 

There are many settings in the AutoSave window, and we suggest you look through the 

MaxImDL manual to find out more details on them. A few particular points are worth 

highlighting; 
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1. Click on a slot’s number to activate/deactivate it. 

2. The base save name of the file is controlled by the “Autosave Filename” 

parameter in the top-left of the window – choose a sensible name for this based 

on either the type of exposure (e.g. bias/dark/flat), or the name of the object 

(e.g. M42). The files will then take the form, e.g. base-NNNx.fits, where ‘base’ is 

the base file name, ‘NNN’ is a sequential number, and ‘x’ is “Suffix” given in the 

autosave form. 

3. “Delay First” does not seem to work… 

4. Turn off “Dither” (top-middle of window) when doing dark/bias calibrations.  

5. It is worth setting the default execution mode to “Group By Slot” (see Figure 16) 

in the “Options” menu (right arrow). This means the software will execute all of 

the observations in slot 1 before moving on to slot 2, rather than executing one 

observation from each slot in a loop. This is more efficient if the slots use 

different filters, for example. 

6. Check there are no active slots “hiding” below the bottom of window (you can 

have up to 30 slots). 

 

Figure 16: Setting the "Group By Slot" parameter 

To close the AutoSave window, click “Apply” and “OK”. To start an AutoSave sequence, 

click the “Start” button on the Exposure panel of the Camera Control window. The 

programme will then execute all the exposures in the sequence. Note to enable 

“autosave” exposures, you need to make sure the radio button next to the autosave button 

is selected. 

5.2.4.1 Storing sequences 

It is possible to store common sequences in a file, so that the can be loaded quickly in the 

future. This is particularly useful for frequently repeated observations, such as flat fields 
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or common objects. Once a sequence has been defined, save it via the “Save Sequence 

As” option on the “Options” menu (Figure 17). This will open up a file browser window. 

Select a directory to store the sequence files, and choose a sensible name. You should 

see a lot of existing sequence files in default directory location. 

You can later reload the sequence file via the “Load Sequence” option (again see Figure 

17). Loading a sequence file will set all parameters in the AutoSave window (including 

base file name, dithering, etc) to the stored values. 

 

Figure 17: Save Sequence As option in AutoSave window 

5.2.5 Focusing 
MaximDL has an automatic focus routine, which can be accessed via the “Focus” tab in 

the “Observatory” window.  

TBF. Rough procedure. 

1. Slew to star ~7th mag 

2. Take a ‘snapshot’ and check the programme finds the right star 

3. Click “Start” and the programme will take images at different focuses, and fit the 

best position. It will move the focuser to the best position 
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Figure 18: Focusing panel of the Observatory window, showing the results of a successful 

focus run. The "V-curve" is clean and well defined, and the software has found a focus 

point at the minimum. 

5.2.5.1 Autofocus settings 

The auto-focus settings should be set by the configuration file, but sometimes it doesn’t 

seem to work. If you’re having problems with autofocusing, it’s worth checking the 

settings. In the focus tab on the Observatory window, click on the “options” button, 

which will bring up the Autofocus Settings window (see Figure 19). Check that the 

setting agree (at least roughly) with the values in Table 1 for your configuration. 
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Figure 19: Autofocuser settings menu. Check the parameters are right for the specific 

configuration you are using (see Table 1). 

Configuration Focuser Step Size 

(microns) 

Focal Ratio Target ½ Flux Dia 

f/6.3 Imaging 5.0 6.3 6.0 

f/10 Imaging 5.0 10.0 8.0 

Table 1: Autofocus settings for different configurations. 

5.2.6 Calibration 
This section provides an overview of the typical calibrations taken for PWT 

observations. 

5.2.6.1 Photometric standard stars 

Photometric standard stars allow you to calibrate your photometry to a standard 

magnitude system so that you can compare your data with other observations from 

different telescopes. They also give information on how clear (transparent) the 

observing conditions are. You should try to take a standard star observation at least 

once during the night. 

As a default, we use the Landolt equatorial standard stars. A list of “standard star of the 

month” is available on the PWT Wiki2 – these stars are visible in the early evening in that 

                                                             

2 http://astrowiki.physics.ox.ac.uk/PWT/ST8CCD  
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month. If you cannot take the standard star data at the beginning of the night, choose 

one of the other stars from the list. 

For standard star data, take 5 exposures in each filter (B, V and R) with 2x2 binning. 

Typical exposure times are about 10-20 seconds, depending on the brightness of the 

star. Sequence files exist for most standard stars, so you can just load and execute the 

relevant sequence. 

5.2.6.2 Darks 

Dark files are used to calibrate the electronic noise in the CCD detector. You should take 

a set of dark frames to match the data you’ve taken throughout the night. Take at least 

10 frames for each CCD configuration (binning) and exposure time used. Darks are 

independent of filters, and the same darks can be used for all filters.  

Normally you can set up the darks to run after you have finished observing and closed 

for the night. They should run unattended OK and be ready when you come in the next 

day. 

5.2.6.3 Flats 

Flat fields correct the uneven illumination of the detector. This comes from dust 

particles on the optics, vignetting of the telescope field, and pixel-to-pixel sensitivity 

variations in the CCD itself. To correct these you should take flat field frames. Flats 

should be taken as often as possible, though if the telescope/CCD configuration has not 

been touched you should be able to use flats from one day to calibrate data from 

another. If the CCD is removed from the telescope, you will need new flat field data. 

Flat fields should be taken for every binning and filter combination you have/plan to 

use.  

5.2.6.3.1 Sky flats 

The best way to take flat fields is to use the clear twilight sky (note, flats taken when 

there are passing clouds are notoriously unreliable). You can do this in the evening just 

after sunset, or in the morning just before sunrise. 

Point the telescope away from the sun, and at an altitude of about 70-80 degrees. Try to 

avoid pointing at the galactic plane (look on the all-sky image in MaxImDL). 

There is a sequence file saved (SkyFlat_mosaic.seq) which runs a mosaic sequence to 

take 9 images at slightly different pointings. Taking data with this sequence file will 

allow you to remove any stars from the final flat field.  

5.2.6.3.1.1 Evening flats 

Evening twilight flats can be started about 5 minutes after sunset if you need 

narrowband flats (H-alpha, SII or OIII). The rough procedure is; 

1. Select the narrowband filter (H-alpha, SII, OII) 

2. Take a 1 second exposure of the sky and measure the average flux with the 

“Information” tool in MaximDL (***FIGURE***). Calculate how long an exposure 
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you need to get ~40,000 counts. If it is less than 2 seconds, wait until the sky 

gets a bit darker. If it is longer than 20 seconds, you’ve probably missed your 

chance! 

3. Take a sequence of frames using SkyFlat_mosaic.seq, aiming to have the 

average flux between 20-40,000 counts. “Comment out” all the other filters. 

If you only need broadband flats (BVR), then you can start ~15-20 minutes after sunset. 

The procedure is the same as above, but in the evening start with the R band filter and 

wait until you have ~40,000 counts in 2 seconds. You can then run R, V and B (in that 

order) with exposure times of 2,3 and 4 seconds respectively. The flats should all be at 

the right level. 

5.2.6.3.1.2 Morning flats 

The same procedures apply as for evening flats, but reverse the order of the filters. Start 

with B and work up to H-alpha as the sky gets brighter. Be very careful that the dome is 

pointing to the West and you will not accidently let the Sun shine on the telescope when 

it rises. 

5.2.6.3.2 Dome flats 

If you cannot get twilight flats for some reason (i.e. cloud), you can take dome flats using 

the internal flat field screen. This is better than nothing, but not as good as sky flats. 

Follow the procedure below; 

1. Move the dome to ~350 degrees (TBC) to bring the flat field screen in front of 

the telescope 

2. Park the telescope, turn off tracking, and slew the telescope to -15 degrees 

declination. The telescope should now be pointing at the flat field screen. You 

may have to adjust the dome pointing slightly to line it up. 

3. Turn on the flat field lamp, which is mounted in a clamp on the South side of the 

telescope mount. Adjust the lamp position so it illuminates the flat field screen as 

evenly as possible 

4. Load and execute the dome_flat.seq (either 1x1 or 2x2 binning, depending on 

your data). Check the count levels are ~40,000 and adjust the exposure time if 

necessary. 

5. Turn everything off, park the telescope and the dome after taking the flats. 

5.3 Shut-down 
This section provides an overview of the steps to shut down the observatory at the end 

of the night.  

5.3.1 Telescope 
The telescope can be “shut down” to two different levels. 
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5.3.1.1 Quick closure 

This method allows you to close the telescope remotely without going to the dome, and 

is appropriate if the weather is OK (no heavy rain forecast) and you’re likely to be 

observing again the following night. 

Find out the local sidereal time from MaximDL (Observatory Window -> Status). 

Slew the telescope to the right ascension equal to the local sidereal time, and a 

declination of -30 degrees. 

Turn off the telescope tracking on POTH 

(The telescope is now parked horizontal, pointing south, with the corrector plate best 

protected from anything falling from above) 

Close and park the dome. 

5.3.1.2 Full closure 

If you won’t be using the telescope the following night, or bad weather is forecast, you 

should close down the telescope fully. 

From the telescope tab in MaxImDL, “park” the telescope. Go up to the dome, turn the 

telescope off at the mount (slide switch) and put the covers on. 

Close and park the dome. 

5.3.2 CCD 
The CCD can be left running. 

5.3.3 Dome 
Once the telescope is parked in a safe location, close the dome on POTH (or MaximDL 

“dome” window). The dome takes 2 minutes to close. Make sure POTH sets the dome 

status to “closed”. “Park” the dome in POTH. You can also check the all sky camera to 

confirm the dome slit is closed (see Figure 20). 
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Figure 20: All Sky Camera image showing a parked and closed dome. The red oval 

highlights the edge of the dome slit, where you can check that the dome is closed. 
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6 Weather 

6.1 Weather limits 
The observatory does not currently have any automatic detection of weather 

(specifically rain). You are responsible for monitoring the weather, and shutting the 

dome if conditions require.  

6.1.1 Rain 
The dome should be closed if there is any rain. If the radar suggests rain in the 

immediate area (50km), only observe if you are absolutely sure it is clear and dry in 

Oxford. In this situation, go outside regularly to check on conditions. If in doubt, close 

the dome. 

6.1.2 Wind 
The dome should be closed if the wind speed is above 30 mph (TBC). Be aware that the 

wind speed reported by the PWT weather station is probably an under estimate of the 

wind speed at the dome (http://weather.globaljetwatch.net/oxford). 

6.1.3 Humidity 
The dome should be closed if humidity is above 97% (TBC). If the local humidity is 

above 90%, check dome for condensation (feel metal surfaces of the mount, and the 

telescope tube). If there is any sign of condensation on the telescope, or inside the dome, 

the dome should be closed. Internal dome humidity (and temperatures) are measured 

every 5 minutes and reported here; 

http://www-astro.physics.ox.ac.uk/~fclarke/WettonObserver/temperatures.html 

6.1.4 Temperature 
There are no limits on operating temperature, but take care on the stairs if it is below 

freezing. 

6.1.5 Snow/Ice 
The dome should not be opened if there is any snow or ice on the dome. 

6.2 Conditions 
There are several useful webpages to check on the current weather conditions. 

6.2.1 All Sky Camera 
The all sky camera located on the stairwell outside the dome is the most valuable 

resource. This takes an image of the sky every minute during the day and night; 

• http://www-astro.physics.ox.ac.uk/~fclarke/ASC/ 
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6.2.2 Cloud/rain monitor  
We are currently (December 2011) testing a new cloud and rain monitor, which is 

located outside the dome next to the all sky camera. The status is not yet available online 

however. 

6.2.3 Satellite images 
IR satellite images updated every 15 minutes are available at; 

• http://www.sat24.com/gb?ir=true (animation of last two hours) 

• http://www.metoffice.gov.uk/public/pws/invent/weathermap/ (becoming 

increasing useful for plotting multiple information) 

6.2.4 Radar images 
Radar images are available from; 

• http://www.metoffice.gov.uk/weather/uk/radar/index.html (updated every 30 

minutes) 

• http://www.sat24.com (updated every 15 minutes) 

6.2.5 Local conditions 
There is a weather station installed on the level 6 roof (below and east of the dome). The 

information from the weather station can be viewed at; 

• http://weather.globaljetwatch.net/oxford/ (do be careful to check the date on 

the graphs, as the station does occasionally crash not update information) 

• http://www-

astro.physics.ox.ac.uk/~fclarke/WettonObserver/temperatures.html for current 

dome internal conditions (including humidity!) 
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7 Trouble-shooting 

7.1 Common problems 

7.1.1 “Home search failed” 
This usually happens if the telescope is too far away from it’s default location when you 

start a home search. Drive the telescope to ~0 degrees declination and pointing due 

South (23hr HA). Re-run the home search. 

7.1.2 MaxImDL keeps trying to run its installer 
Not sure why this happens!! There is a problem with the permissions and installer 

location somewhere, but I’m not sure where yet. Click “cancel”, and most things will 

work anyway. 

November 2011 – think this has been fixed… please let fraser.clarke@physics.ox.ac.uk 

know if you come across this problem again. 

7.1.3 MaximDL won’t connect to the telescope 
This problem occurs when you try to connect to the telescope from MaximDL, it starts 

POTH and connects to the telescope, but then MaximDL reports an error claiming it 

cannot connect to the telescope. Trying again sometimes works, but if not the only 

solution I’ve found so far is to reboot wettonpc1. 

7.1.4 POTH crashes and refuses to restart 
Start the task manager and look for the task “MeadeExDriver” and kill this. Try POTH 

again. 

If it still fails, try closing and restarting MaxImDL. 

If it still fails, you’ll probably need to reboot wettonpc1. 

7.1.5 How do I start “TaskManager” over a remote de sktop? 
“Start->Windows Security” brings up the options you’d get by pressing Ctrl-Alt-Del on 

the local machine. 

7.2 Remote Support 
wettonpc1 has “teamviewer” software installed, which allows someone to connect 

remotely and see the user’s desktop. This is very helpful for remote troubleshooting. 

Note that teamviewer cannot be used at the same time as remote desktop. To use 

teamviewer; 

• Observer starts teamviewer from the icon on the desktop 

• Observer lets remote supporter know ID (872051022) and password (changes 

each session). See Figure 21. 

• Observer may have to disconnect from their remote desktop session, if 

applicable. Observer could reconnect using teamviewer if desired. 
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• Supporter connects to 872051022 through their teamviewer using password, 

and can now control wettonpc1 without logging out the observer. 

• Once problem is fixed, supporter logs off from teamviewer and observer can 

reconnect via remote desktop (or continue connection through teamviewer). 

 

Figure 21: Teamviewer started up showing User ID and Password. The password changes 

each session. 

7.2.1 Downloading teamviewer 
http://www.teamviewer.com has versions for Windows, Mac and Linux. 

7.3 Contact information 
Fraser Clarke: fraser.clarke@physics.ox.ac.uk 

Office: (2)83140 

Mobile: 07743 932776 


